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CHAPTER 1

Introduction

Welcome to RVONedit

RVONedit is a Windows-based GUI (Graphical User Interface) application for configuring and displaying RVON (VoIP)
devices connected to your Matrix system. RVONedit is to the VoIP products as AZedit is to ADAM, ADAM CS, Cronus, and
Zeus. The RVON devices included are:

RVON-8
RVON-I1/O
RVON-Keypanel
RVON-C
RVON-16

To fully use the RVONedit application, you must have the following minimum version installed:

FIRMWARE VERSION
RVON-8 V 2.0.0 or later
RVON-Keypanel V 2.0.0 or later
RVON-1/0 V 2.0.0 or later
RVON-C V 2.0.0 or later
RVON-16 V 2.1.3 or later
NOTE: RVONedit can download firmware to older versions, but requires these versions in order to automatically detect

the devices and to view or modify the device configurations. For more information, see “How to Update Older
Version RVON Devices Using RVONedit” on page 84.




Getting Started with RVONedit

Once you have updated the firmware for each RVON device through AZedit, serially, or by using Telnet, you can start using
RVONedit by itself.

NOTE: When RVONedit is setup, you will be able to download firmware upgrades from the RVONedit Window.

Step 1

Using the RVONedit installation wizard, install RVONedit on the PC connected to the Intercom System (ADAM, ADAM
CS, Cronus, or Zeus).

Step 2

Add Devices to the RVONedit application. This can be done manually or automatically. For more information, “How to
Add Devices to RVONedit” on page 54.

Step 3

Using the Device Configuration section of the RVONedit Window configure your RVON device.

RVONedit Field Types

FIGURE 1. RVONedit Field Types




CHAPTER 2

Application Window Descriptions

RVONedit Main Application Window

The Main Application window, shown in Figure 2, is split into three (3) areas which are described in detail on the following
pages.

NOTE: RVONedit version 2.0.0 and higher is now able to open more than one window at a time. You can now view or
edit multiple devices at the same time. For more information, see “How to Open Multiple Windows in
RVONedit” on page 53.

FIGURE 2. RVONedit Main Application Window




Device Catalog

The Device Catalog, shown in Figure 3, is used to view the RVON devices you have selected and connected to your Intercom
System.
NOTE: You can also double-click By Device Type or All Devices to open and close the catalog tree.

e When displaying All Devices, RVONedit, by default, displays the RVON devices in order of how the
devices were added to the application.

*  When displaying the RVON devices by Device Types, color-coded squares appear to distinguish
between the different RVON devices.

@ RVON-8 @ RVON-Keypanel@ RVON-I/O. RVON-C @ RVON-16

NOTE: Initially, when RVONedit is installed, the device catalog is empty. Remember to update your RVON firmware to
the minimum requirements (see page 3) before you add devices to RVONedit.

There are two ways to view these devices: E All Devices or E by Device Type.

FIGURE 3. Device Catalog




The Device Catalog uses expandable/collapsible trees. By clicking the + symbol, you can expand a catalog, or click - to
collapse the catalog.

Once you have finished adding the RVON devices to the catalog, you can now display its configuration and status section in
the RVONedit window.

Device Configuration and Status Field

The Device Configuration and Status section, shown in Figure 5, is used to enter information about the selected device.

Device Information is grouped into four (4) sections:

Device Information and Status
Pass-Through and/or GP1O Support Information
SNMP Information

Authentication Information

FIGURE 4. Device Configuration and Status Section




Device Information and Status Section

The Device Information and Status section, shown in Figure 5, is used to configure and display your RVON device
configuration.

NOTE: Using the Expand/Collapse button _J you can expand or collapse each section of the Device Configuration and
Status section. When collapsed, only the section heading appears.

FIGURE 5. Device Information and Status window

Configuration Group Box

NOTE: All of the following fields, except Description, require Admin Privileges to modify their contents. Changing the
IP Address, Netmask, or Gateway causes the device to reboot when the changes are sent.

Description Field

The Description field is used to enter a text description of the device. This description can be displayed instead of the IP
Address in the Device Catalog, see “Use Device Descriptions in the Device Catalog” on page 65.

This field can contain up to 63 characters.

IP Address Field
The IP Address field is used to enter the IP Address for the selected RVON device.

Netmask Field

The Netmask field is used to enter the Network Mask Address? to which the device is connected.

Gateway Field

The Gateway2 field is used to enter the default Gateway Address, if applicable, of the network to which the RVON device is
connected.

1. A 32-bit mask which shows how an Internet Address is to be divided into network, subnet and host parts.

2. The computer or device onto which the first hop needs to go to get out of your network and onto another network or the Internet. The
gateway, as it relates to TCP/IP, is tried when a resource is not found on the local network




Version Field

The Version field displays the current firmware version of the RVON device.

Disable Auto-Negotiation Check Box

The Disables Auto-Negotiation check box is used to disable the auto-negotiate feature and activate the Mode and Speed radio
buttons.

Available selections for this field are:

Full Duplex - data moves both directions simultaneously
Half Duplex - data moves in one direction at a time

100 Mbps

10 Mbps

Status Group Box

Type Field
The Type field displays the type of RVON device being configured and what mode it is running in.

Status Field

The Status field displays the current status of the RVON device and the current access rights of the user.

Sessions Field

The Sessions field displays the number of RVONedit sessions the device supports and how many are available (for example,
15/16 Available).

Channels Field

The Channels field displays the VoIP connection states for each channel.
green—connected
red—disconnected

grey—not configured

Keypanels Field

The Keypanels field displays the keypanel connection states for each channel
green—connected
red—disconnected

grey—not configured




Pass-Through and/or GPIO Information Section

The Pass-Through and/or GP10 Information section, shown in Figure 6, is used to configure the pass-through GP10
settings for an RVON device (if applicable).

NOTE: Using the Expand/Collapse button _J you can collapse or expand each section of the Device Configuration and
Status section. When collapsed, only the section heading appears

FIGURE 6. Pass Through and/or GP1O Information.

Serial To Ethernet Group Box

The Serial To Ethernet group box displays the serial data received on the serial connection and transferred to the Ethernet
Address of the device to which the serial data is sent.

Tx IP Address Field
The TX IP Address field is used to enter the IP Address of the device the serial data is sent.

Destination Port Drop Down Menu

The Destination Port drop down menu is used to select which port is assigned as the destination port when connecting to an
RVON-16.

Available selections for this field are 1 and 2.

NOTE: The RVON-16 provides two (2) virtual serial connections via an IP connection. Which, if used while trunking,
may eliminate the need for multiple IP resources.

Baud Rate Drop Down Menu

The Baud Rate drop down menu is used to select the baud rate of the serial connection.

Available selections for this field are:
9600
19200
38400

Bytes Transferred Field

The Bytes Transferred field displays the number of bytes transferred from the serial connection to the Ethernet.
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Bytes Lost Field
The Bytes Lost field displays the number of bytes that could not be transferred.

Errors Field

The Errors field displays the number of errors that occurred during transfer.

Ethernet To Serial Group Box

The Ethernet To Serial group box displays the serial data received on the Ethernet connection and transferred to the serial
connection.

Rx IP Address

The Rx IP Address field displays the IP Address from which data was last received via Ethernet (this address should match
the Tx IP Address).

Destination Port Field
The Destination Port field displays which port is assigned as the destination port when connecting to an RVON-16.

NOTE: The RVON-16 provides two (2) virtual serial connections via an IP connection. Which, if used while trunking,
may eliminate the need for multiple IP resources.

Unexpected Bytes Field

The Unexpected Bytes field displays the number of unexpected bytes of data. Unexpected bytes is data that comes from any
IP Address that is not the Tx IP Address.

NOTE: These bytes of data are considered invalid bytes and are not transmitted.

Bytes Transferred Field
The Bytes Transferred field displays the number of bytes transferred to the serial port.

Bytes Lost Field
The Bytes Lost field displays the number of bytes that could not be transferred.

Errors Field
The Errors field displays the number of errors that occurred during the transfer.
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GPI1O Group Box

Mode Drop Down Menu
The Mode drop down menu is used to select the mode in which the GPIO are to be used.

When configuring the GPIO mode on the RVON-I/O, there are three (3) different mode options you may choose from:

Pass-Through Mode: In pass-through mode, GPIO status is sent over Ethernet, therefore you must set the
IP Address of the destination GPIO pass-through port.

1 Keypanel Mode: In 1 keypanel mode, also referred to as single port mode, all GPIOs with a keypanel
allow you to access/address the GPIO in UPL statements.

All Keypanel Mode: In all keypanel mode, also referred to as multiple port mode, each keypanel is
associated to its corresponding GPIO. For example, if keypanel 1 is connected to
GPIO 1, it is associated with the corresponding GP10 port. When using All Keypanel
Mode, an additional GPI1O is available. This means that each keypanel has four (4)
GPIOs and then a GPIO associated with port 9.

NOTE: The extra port 9 is only available in ADAM intercom systems.

IP Address Field

The IP Address field is used to enter the IP Address of the device with which GPIO states are transferred. This option is only
valid when the GP1O mode is set to Pass-Through.

Keypanel Drop Down Menu

The Keypanel drop down menu is used to select the device port/keypanel number with which all GP1Os are associated. This
option is only valid when GPIO mode is set to All Keypanel Mode.

Available selections for this field are 1 through 8.

Inputs Field
The Inputs field displays a summary of the current GPIO input states.

GPIO input states are as follows:
purple ..o asserted

Oray cceeveeereeeeeeeans output not asserted

Outputs Field
The Outputs field displays a summary of the current GPIO output states

GPIO output states are as follows:
purple ....cccoovvrieiins asserted

Oray .ceveceereeeeeeens output not asserted
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SNMP Information Section

The SNMP Information section, shown in Figure 7, is used to configure the SNMP (Simple Network Management Protocol)
options for your RVON device, if applicable.

NOTE: This section is only shown if the device has SNMP support and the preference to Hide SNMP Configuration is
not enabled (see “How to Show/Hide the SNMP Configuration Information” on page 66).

FIGURE 7. SNMP Information

Using the Expand/Collapse button _J you can expand or collapse each section in the Device Configuration section. When
collapsed, only the section heading appears.

There are four (4) areas within the SNMP Sections:
e System Information
e Community Strings
e Valid Hosts
e Trap Targets

System Information Group Box

The System Information group box is purely for documentation purposes. This information displays which device is
configured and where it is physically located.

Name Field
The Name field is used to enter the name of the RVON device in which SNMP is being configured.

This field can contain up to 100 characters.
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Location Field
The Location field is the physical location of the intercom system (for example, 3rd floor, Sacramento).

This field can contain up to 100 characters.
Contact Field
The Contact field allows you to enter the name of the person responsible for the specified SNMP device.

This field can contain up to 100 characters.

Community Strings Group Box

Read-Only Field
The Read-Only field allows you to set the password that provides read-only access via SNMP.

The default entry is public. Public allows everyone every access to Read the SNMP structure.

Read-Write Field
The Read-Write field allows you to set the password that provides read-write access via SNMP.

Traps Field

The Traps field is used to enter the trap identifier for SNMP event monitoring.

A SNMP Trap is a notification event issued by a managed device (the Intercom System) to the network management station
when an event or error occurs. When an event or error occurs, a message is sent to the SNMP monitoring software with the

Trap Community String description.

The Traps Community String specifies the community string included in all SNMP traps generated by the intercom

Valid Hosts Group Box

IP Address Field

The IP Address field allows you to add up to five (5) IP Addresses of host machines that accept SNMP requests. You must
enter a valid IP Address structure for the Add button to become active.

Use List of Valid Hosts? Check Box

The Use list of valid hosts? check box is used to allow queries to the specified SNMP monitoring machines. You can specify
the IP Address of these machines in the Valid Host IP Address list.

Add Button
The Add button adds the IP Address of the SNMP monitoring machine to a list of approved IP Addresses.

Remove Button

The Remove button removes the selected IP Address of the machine.
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Trap Target Group Box
A list of up to five (5) targets the device sends SNMP traps to when they occur.

IP Address Field

The IP Address field allows you to add up to five (5) IP Addresses of host machines that accept SNMP requests. You must
enter a valid IP Address structure (xxx.xxx.xxx.xxx) for the Add button to become active.

Use List of Valid Hosts? Check Box

The Use List of Valid Hosts? check box is used to allow queries to the specified SNMP monitoring machines. You can specify
the IP Address of these machines in the Valid Host IP Address list.

Add Button
The Add button adds the IP Address of the SNMP monitoring machine to a list of approved IP Addresses.

Remove Button
The Remove button removes the highlighted IP Address of the machine.

Authentication Information Section

FIGURE 8. Authentication Information

The Authentication Information section, shown in Figure 8, is used to configure up to five (5) user profiles for the selected
device. Each profile can be given different access rights or privileges: Admin, Read, Write, Telnet, and Download.

NOTE: Access rights, also called privileges, are an identified set of rights an individual user or group of users has to a
particular resource. The RVON devices support an authentication table that can contain up to five (5) entries
(each with a user name, password, and access rights).

Access Rights for the RVON devices are as follows:

R Read (user can view status and configuration)

w Write (user can modify most configurable elements)

A Admin (user can modify advanced configuration elements)
T Telnet (user can connect to the device via Telnet)

D Download (user can download new firmware to the device)
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CAUTION: It is possible to create an empty authentication table, disabling RVONedit, Telnet, and firmware downloads. If
this occurs, do the following:

Using Table 1 on page 16, turn ON the appropriate DIP switch.

Restart the device.

Once the device has been restarted, turn the DIP switch OFF.

Restart the device.

A w0 DR

The following is a list of the DIP switch numbers for each RVON device type:

TABLE 1. DIP Switch for Resetting Authentication Table

RVON-8 DIP Switch 5
RVON-Keypanel DIP Switch 2
RVON-1/0 DIP Switch 3
RVON-C DIP Switch 5
RVON-16 DIP Switch 5
NOTE: This section is only shown if the current access rights include admin and the preference option Hide

Authentication Table is not enabled (see “How to Show/Hide the Authentication Table” on page 67).

FIGURE 9. Edit Authentication Information

NOTE: Using the Expand/Collapse button _J you can expand or collapse each section in the Device Configuration
section. When collapsed, only the section heading appears.

When creating the profiles, the following must be observed:

User Name — Can be up to 40 characters long
Password — Can be up to 40 characters long
Access Rights — Select the access for the user you are creating.

Recommendations:

e For security purposes, it is recommended you change the authentication table default user names and passwords
so they are not easily accessible by anyone on your network.

*  We also recommend you set an application default login user name and password when logging onto different
devices. By enabling this feature, RVONedit remembers the user names and passwords to logon to each device,
especially if you are planning to make different authentication tables for each device. By having RVONedit store
the logon information, you will eliminate having to logon to each device.
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Channel Configuration And Status Section

The Channel Configuration and Status section, shown in Figure 10, is used to configure or view the channels for each
RVON device. Channel Configuration and Status is divided into five sections:

Channel Configuration
Channel Status

VOIP

Network Status

Error

FIGURE 10. Channel Configuration and Status

Channel Configuration

Use the Channel Configuration section of the grid to configure channel settings for each applicable device channel.The
channel configuration displays the following fields: Channel Description, Destination Type, Destination IP Address,
Destination Description, Destination Channel, Destination Channel Description, Coding Algorithm, Audio/Packet, VAD State,
VAD Threshold, Channel Input Gain, Channel Output Gain, Keypanel Polling ID, and Keypanel Polling Baud Rate.
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NOTE: If you are connected to a device with Write or Admin privileges, a context menu is available that allows you to
Tear Down Channels (right-click in the left title column) or Tear Down Individual Channels (right-click the
channel column header). For information on how to tear down channels, see “How to Tear Down a Channel” on
page 79.

FIGURE 11. Channel Configuration

Channel Description Field

The Channel Description field is used to enter the channel description, if applicable. To change the description, we
recommend you use the description field in Device Information on page 8.

This field can contain up to 63 characters.

Destination Type Drop Down Menu

The Destination Type drop down menu is used to select the type of RVON device to which the channel is connected.
Selections available for this field are: RVON-8, RVON-Keypanel/VKP, RVON-1/0, RVON-C, and RVON-16.

NOTE: When the RVON device is initially added to RVONedit, these fields automatically populate with the current
channel status.

Destination IP Address Field
The Destination IP Address field is used to enter the IP Address for the device at the other end of the connection.

IMPORTANT: This is an editable field. You can enter another IP Address. However, by changing this IP Address, the
destination type changes ifthe destination device type can be determined.

Destination Description Field

The Destination Description field displays the destination channel’s description, if applicable.

This field cannot be modified.
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Destination Channel Drop Down Menu

The Destination Channel drop down menu is used to select the channel at the destination device to which the RVON device is
connected. Use Table 2 on page 19 to determine the number of channels available for every device type.

NOTE: When <default> is selected, the channels match 1 to 1. For example, you may have all channels selected, and by
choosing <default>, Ch1 matches to Ch1, Ch2 matches Ch2, etc. This option is a time saver so you do not have to
manually assign each channel.

TABLE 2. Destination Channel Drop Down Menu Options

RVON-8 RVON\;E?Qpa”e” RVON-1/0 RVON-C RVON-16
Channel 1 Channel 1 Channel 1 Channel 1 Channel 1
Channel 2 Channel 2 Channel 2 Channel 2 Channel 2
Channel 3 <default> Channel 3 Channel 3 Channel 3
Channel 4 Channel 4 Channel 4 Channel 4
Channel 5 Channel 5 Channel 5 Channel 5
Channel 6 Channel 6 Channel 6 Channel 6
Channel 7 Channel 7 Channel 7 Channel 7
Channel 8 Channel 8 Channel 8 Channel 8
<default> <default> <default> Channel 9
Channel 10
Channel 11
Channel 12
Channel 13
Channel 14
Channel 15
Channel 16
<default>

a. The VKP device works on channel 1 only.

Destination Channel Description Field

The Destination Channel Description field displays the destination channel’s description, if available.

This field cannot be modified.
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Coding Algorithm Drop Down Menu

The Coding Algorithm drop down menu is used to select the coding algorithm used to transmit audio packets.

Available selections for this field are G.711x law, G.711A law, G.729AB, G.723 (5.3k), and G.723 (6.3Kk).

NOTE: A Codec® (Coder/Decoder) is an algorithm used to compress audio. There are 5 codecs supported by Telex:
G.711p law, G.711A law, G.729AB, G.723 (5.3k), and G.723 (6.3K).

The type of codec chosen dictates the quality of audio you hear and the network bandwidth used. The packet size
determines how much audio data is carried across the network in each transmitted packet. The codec type and
packet size chosen require different amounts of bandwidth from the network. As with the codec type, the packet
size you choose for the audio transfer affects the audio you hear and the bandwidth you use over the network.
The larger the audio packet you choose to use, the lower the bandwidth used. However, the larger packet size can
result in a higher delay and longer gaps if the packet is lost. On the other hand, smaller packet sizes result in
larger bandwidth use, but lower delays and smaller gaps if the packet is lost. The Intercom System Engineer and
the Network Administrator may want to work together in choosing the codec type and packet size suitable for the
size of the network, so degradation of network resources does not happen

Audio/Packet Drop Down Menu

The Audio/Packet drop down menu is used to select the audio packet size to transmit.

Field options available are: 30ms and 60ms.

NOTE: A Codec? (Coder/Decoder) is an algorithm used to compress audio. There are 5 codecs supported by Telex:
G711y law, G.711A law, G.729AB, G.723 (5.3k), and G.723 (6.3k).

The type of codec chosen dictates the quality of audio you hear and the network bandwidth used. The packet size
determines how much audio data is carried across the network in each transmitted packet. The codec type and
packet size chosen require different amounts of bandwidth from the network. As with the codec type, the packet
size you choose for the audio transfer will affect the audio you hear and the bandwidth you use over the network.
The larger the audio packet you choose to use, the lower the bandwidth used. However, the larger packet size can
result in a higher delay and longer gaps if the packet is lost. On the other hand, smaller packet sizes result in
larger bandwidth use, but lower delays and smaller gaps if the packet is lost. The Intercom System Engineer and
the Network Administrator may want to work together in choosing the codec type and packet size suitable for the
size of the network, so degradation of network resources does not

VAD State Check Box

The VAD State check box is used to enable VAD® (Voice Activity Detection)on the RVON device. VAD saves network
bandwidth by stopping the flow of audio packets when silence is detected.

VAD Threshold Scroll Arrows

The VAD Threshold scroll arrows are used to configure the VAD threshold (for G.711) codec). Setting the VAD threshold tells
the channel at what level to start the flow of audio packets. Otherwise, the channel remains silent.

The range for this field is -60dBm to -30dBm, or Adaptive.

NOTE: The Adaptive option configures its own threshold based on the background noise it determines.

3. This type of codec combines analog-to-digital conversion and digital-to-analog conversion functions in a single chip.
4. This type of codec combines analog-to-digital conversion and digital-to-analog conversion functions in a single chip.

5. VAD allows a data network carrying voice traffic over the Internet to detect the absence of audio and conserve bandwidth by preventing
the transmission of silent packets over the network.
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Channel Input Gain Scroll Arrows

The Channel Input Gain scroll arrows are used to configure the channel input gain for the channel.
The range for this field is -14dB to 14dB.

NOTE: This field is not editable for devices that get input gain from the intercom.

Channel Output Gain Field

The Channel Output Gain scroll arrows are used to configure the channel output gain for the channel.
The range for this field is -14dB to 14dB.

NOTE: This field is not editable for devices that get output gain from the intercom.

Keypanel Polling 1D Drop Down Menu

The Keypanel Polling ID drop down menu used to select the keypanel polling ID for the channel.
Available selections for this field are -, 1, 2, 3, 4, 5, 6, 7, 8, 9, 10. The dash represents no polling ID.
NOTE: This field is only used with the RVON-I/O in remote mode.

Keypanel Polling Baud Rate Drop Down Menu

The Keypanel Polling Baud Rate drop down menu is used to select the baud rate at which communication is expected to
operate.

Selections for this field are 9600, 19200, or 38400.

NOTE: This field is only used with the RVON-I/O in remote mode.

Channel Status

The Channel Status displays read-only status information on the channel’s connection and communication status.

NOTE: If you are connected to a device with Write or Admin privileges, a context menu is available that allows you to

Clear Connection Statistics for all channels (right-click in the left title column) or Clear Connection Statistics for
Individual Channels (right-click in the channel column).
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FIGURE 12. Channel Status

Connection State Field

The Connection State field displays the state of the connection.

There are two connection states: Connected or Idle.

Connection Duration Field

The Connection Duration field displays the duration of the current connection or the previous connection, if in an idle state.

The connection duration is shown in hh/mm/ss.

Coding Algorithm (actual) Field

The Coding Algorithm (actual) field displays the coding algorithm negotiated for use with the connection. When this is
displayed in red, it is different from the configured algorithm.

Audio/Packet (actual) Field

The Audio/Packet (actual) field displays the audio per packet size of the current connection. When this is displayed in red, it
is different from the configured audio/packet value.

VAD State (actual) Field

The VAD State (actual) field displays the current VAD state. When this is displayed in red, it is different from the configured
VAD state.

Connection Attempts Field

The Connection Attempts field displays the number of times a call has been made.

NOTE: The number of attempts should always be one greater than the number of drops.
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Connection Drops Field

The Connection Drops field displays the number of times a connection has been dropped.

Connection Origination Field

The Connection Origination field displays the end of the connection that originated the call.

Connection Termination Field

The Connection Termination field displays the end of the connection that terminated the call.

Release Reason Field

The Release Reason field displays why the connection was terminated. For example, congestion, network error, local release,
or remote release.
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VOIP Status
The VOIP Status displays read-only statistics and counters related to VOIP.
NOTE: If you are connected to a device with Write or Admin privileges, a context menu is available that allows you to

Clear VOIP Statistics for all channels (right-click in the left title column) or Clear VOIP Statistics for Individual
Channels (right-click in the channel column).

FIGURE 13. VOIP Status

Playout Buffer Size Field
The Playout Buffer Size field displays how much audio can be received from the network before packets are lost. This is four
(4) times bigger than the configured packet size.

This is a static system setting.

Nominal Playout Delay Field
The Nominal Playout Delay field displays how much audio is collected before playout begins. Playout begins at half the
playout buffer size, which is two (2) times the configured packet size.

This is a static system setting.

Average Playout Delay Field

The Average Playout Delay field displays the actual average audio collected before packets are played out. The average
playout delay is measured over the length of the connection.

Playout Buffer Underrun Field

The Playout Buffer Underrun field displays the number of times that packets were not played because the playout buffer was
empty.

Playout Buffer Overrun Field

The Playout Buffer Overrun field displays the number of packets discarded because the playout buffer was full.

Missing Sequence Packets Field

The Missing Sequence Packets field displays how many audio packets were missed in the sequence.
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Replayed Packets Field

The Replayed Packets field displays how many audio packets were replayed.

Average Frame Jitters Field

The Average Frame Jitters field displays the measure of consistency of packet arrival time. Lower jitter is better.

Network Status
The Network Status displays read-only network statistics and counters.
NOTE: If you are connected to a device with Write or Admin privileges, a context menu is available that allows you to

Clear Network Statistics for all channels (right-click in the left title column) or Clear Network Statistics for
Individual Channels (right-click in the channel column)

FIGURE 14. Network Status

Voice Playout Packets (Tx/Rx) Field

The Voice Playout Packets (Tx/Rx) field displays the number of voice packets transmitted and received from the other side of
the connection.

DTMF Relay Packets (Tx/Rx) Field

The DTMF Relay Packets (Tx/Rx) field displays the number of DTMF (Dual Tone Multiple Frequency) relay packets
transmitted and received. DTMF relay packets are a bandwidth and quality saving feature within RVON products.

Silence Detection Packets (Tx/Rx) Field

The Silence Detection Packets (Tx/Rx) field displays the number of times a silence detection packet has been sent or
received. VAD must be enabled.

Packet Interarrival Time (Min/Max) Field

The Packet Interarrival Time (Min/Max) field displays the minimum and maximum time elapsed between packets being
sent.

Recent Bandwidth Use (Tx/Rx) Field
The Recent Bandwidth Use (Tx/Rx) field displays the amount of bandwidth used, in Kbytes/sec, over the length of the call.
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Average Bandwidth Use (Tx/Rx) Field
The Average Bandwidth Use (Tx/Rx) field displays the amount of bandwidth used, in Kbytes/sec, over the length of the call.

This is a calculation of the number of voice packets transmitted and received and the length of the connection.

Errors Grid

The Errors Grid displays the read-only error counters.

NOTE: If you are connected to a device with Write or Admin privileges, a context menu is available that allows you to

Clear Error Statistics for all channels (right-click in the left title column) or Clear Error Statistics for Individual
Channels (right-click in the channel column).

FIGURE 15. Errors Grid

Invalid Headers Field

The Invalid Headers field displays how many IP packets could not be parsed.

Invalid MAC Address Field
The Invalid MAC Address field displays how many invalid MAC Addresses tried to connect.

Invalid SSRC Field

The Invalid SSRC field displays the number of packets with an invalid SSRC.

Invalid Payload Field

The Invalid Payload field displays how many incorrectly formatted packets were received.

Invalid Destination Field

The Invalid Destination field displays how many invalid destinations were received.

Lost Packets Field

The Lost Packets field displays how many packets were lost.
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DSP to Micro Overrun Field

The DSP to Micro Overrun field displays the number of packets that were lost because the micro was too busy to receive.

Change User Window

The Change User window, shown in Figure 16, is used to logon to RVON devices in RVONedit as different preestablished
users. RVONedit administrators have the ability to create up to five (5) different user profiles with unique access rights/
privileges (see page 3). This gives administrators the power to limit access to change device configuration values to a few
users. User profiles are created in the Authentication area of the Device Configuration and Status section. For more
information, see “How to Add/Remove a User Profile To/From the Authentication Table” on page 71.

NOTE: By default, RVONedit is shipped with two default user profiles: admin and telex. They both have the same
default password: password. We highly recommend you give each user profile a unique password to prevent a
security risk to your RVON device configurations.

FIGURE 16. Change User Window

Authentication Group Box

NOTE: User names and passwords must be setup in Authentication Information in the Device Configuration window.
For more information, see “Authentication Information Section” on page 15.

The Authentication group box contains the following information:

User Name Field

The User Name field is used to enter a user name.

This field can contain up to 40 characters.

Password Field

The Password field is used to enter the password assigned to the user name entered.

This field can contain up to 40 characters.
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Save Button

The Save button saves the user name and password for future logons to the RVON device. The save function remembers the
user name and password for the next time the RVON device is accessed, allowing the user to forego entering a user name and
password. This is convenient when there are many RVON devices accessed on a routine basis.

IMPORTANT: You must click OK after the save is performed to store the user name and password for the RVON
device.

OK Button
The OK button submits the user name and password entered to the intercom system.

* If correct, the RVON device is accessible with the user rights assigned to the user name.
e Ifincorrect, the Change User window reappears with the user name field populated with no password entered.

Cancel Button

The Cancel button disregards the information entered in the fields and closes the Change User window.
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Manage Logins Window

The Manage Logins window, shown in Figure 17, is used to manage the login for one (1) or more RVON devices at a time.
The Manage Logins window is similar to the Change User window except you can set user names and passwords for multiple
RVON devices without having to individually select the RVON device.

Depending on how you want to configure your user name and password configurations, there are three (3) ways to open the
Manage Logins window:

For one device

For all devices

For all devices of a certain device type
For more information, see “How to Open the Manage Logins Window” on page 86.
NOTE: By default, RVONedit is shipped with two default user profiles: admin and telex. They both have the same

default password: password. We highly recommend you give each user profile a unique password to prevent a
security risk to your RVON device configuration.

FIGURE 17. Manage Logins Window

Set User Name and Password for Connecting to Selected Devices Group Box

Select Devices to Manage List

The Select Devices to Manage list displays a selectable list of devices in which user names and passwords can be configured.

User Name Field

The User Name field is used to enter the user name for the selected devices.

This field can contain up to 40 characters.
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Password Field

The Password field is used to enter a password for the user name specified. Passwords are a string of characters a user must
enter to gain access to a resource.

This field can contain up to 40 characters.

Store For Selected Devices Button

The Store for Selected Devices button stores the specified user name and password for the device selected in the Select
Devices to Manage list. If this option is utilized, when the device is accessed, the configured user name and password is
required to gain access to the device. This feature can be used as a security feature when allowing remote access to your
RVON devices.

Example: For example, if a remote truck is configuring an RVON 8 device and wants to verify the correct
configuration with the studio location’s RVON 8 device, the studio location can assign a user name and
password that has Read Only access to the information. Once the RVON device is added to the remote
location RVONedit application, the remote truck technician can logon and view the configuration
settings.

NOTE: When configured, the Stored user name and password always supercedes the application default user name and
password. If there is no stored user name and password established, the RVON device looks for the default user
name and password. If there is no default user name and password established, the RVON device uses the user
name: telex and password: password.

Set as Application Default Button

The Set as Application Default button sets the entered user name and password as the default for the selected devices in the
Select Devices to Manage list. This feature allows the user to assign the same default user name and password to many devices
simultaneously. This can save time when configuring login information for many devices.
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Example: For example, you can assign a specific user name and password to each RVON device type in your
device catalog, as shown in Figure 18. You can also set a global user name and password that applies to
all RVON device types.

FIGURE 18. Manage Login Window - Set As Application Default Example

NOTE: You must have each user name and password defined in the Authentication Information window (see
“Authentication Information Section” on page 15). For more information, see “How to Add/Remove a User
Profile To/From the Authentication Table” on page 71.

Done Button

The Done button closes the Manage Login window.

Preferences Dialog

The Preferences window allows you to set application, device and channel options for RVONedit.

The Preferences window has four pages:
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e Catalog page - Allows you to set display options for the device catalog, such as the way RVON devices are seen.

*  Devices page - Allows you to set options for device preferences, such as auto-connecting and displaying device
configuration areas.

e Channels page - Allows you to set options for channel configurations such as, column and row adjustments and
display options for RVON-Keypanel aux channel.

* Directories page - Allows you to set file locations for save and load directory defaults.

You can also open preferences by selecting Edit|Preferences, by pressing Alt+Enter, or clicking the preferences icon v :

Catalog Page

FIGURE 19. Catalog Page - Preferences Window

Use Description Instead of IP Address If Available Check Box

The Use Description Instead of 1P Address If Available check box allows the user to see the RVONedit device descriptions,
instead of the device IP Address. For example, if you have an RVON device with an IP Address, 10.2.210.10, and a
description, slot 2; in the Device Catalog, the description, slot 2 will be seen instead of the IP Address.

Show All Devices Check Box

The Show All Devices check box allows the user to display all RVONedit devices in the Device Catalog, under the All
Devices heading.

Show By Device Type Check Box

The Show By Device Type check box allows the user to display all RVONedit devices grouped by device type. For example,
RVON-8, RVON-Keypanel, etc.
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Devices Page

FIGURE 20. Devices Page - Preferences Window

Auto-Connect When Changing Devices Check Box

The Auto-Connect When Changing Devices check box allows the user to auto-connect to RVONedit devices. This means
that when devices are changed within the device catalog, RVONedit automatically connects the device or the user name and
password window automatically displays for logon.

Hide SNMP Configuration Check Box

The Hide SNMP Configuration check box allows the user to hide the SNMP configuration area. If you do not use the SNMP
feature, you can hide the configuration options located in the Device Configuration and Status section.

For more information, see “How to Show/Hide the SNMP Configuration Information” on page 66.

Hide Authentication Table Check Box

The Hide Authentication Table check box allows the user to hide the Authentication table area. If you do not use the
authentication feature, you can hide the configuration options located in the Device Configuration and Status section. For
more information see, “How to Show/Hide the Authentication Table” on page 67.

NOTE: SNMP and Authentication information is only visible with logged in as admin.
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Channels Page

FIGURE 21. Channels Page - Preferences Window

Allow Row Height Adjustments Check Box

The Allow Row Height Adjustments check box allows the user to make row height adjustments to the channel configuration
grid.

Allow Column Width Adjustments Check Box

The Allow Column Width Adjustments check box allows the user to make column width adjustments to the channel
configuration grid.
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Directories Page

FIGURE 22. Directories Page - Preferences Window

Device Catalog (.RVC) Field

The Device Catalog (.RVC) field allows you to set the file location where the device catalog settings are stored. By default,

the device catalog settings are stored in C:\Telex\RVONedit\CATALOG. Use the browse button _| to navigate to where you
want to store these files.

Device Setup Files (.RVC) Field
The Device Setup Files (.RVC) field allows the user to set the file location where the device setup files are stored. By default,
the device settings files are stored in C:\Telex\RVONedit\SETUPS.Use the browse button —I to navigate to where you want to

store these files.

Firmware Files (.BIB) Field

The Firmware Files (.BIB) field allows the user to set the file location where the firmware files are stored. By default, the

firmware files are stored in C:\TelexX\RVONedit\FIRMWARE.Use the browse button —l to navigate to where you want to store
these files.

Add Device Window

The Add Devices window, shown in Figure 23 to add RVON devices to RVONedit. There are two ways to add devices on the
Add Device window:

* You can manually enter the device information. Use the Add page to perform a search for a specific RVON
device by manually entering the IP Address.

* You can search through a list of IP Addresses. Use the Search page to look through a list of all configured RVON
devices. When you highlight a device in the Available Devices list, the device information auto-populates the
right portion of the window.
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For more information, see “How to Add Devices to RVONedit” on page 54.

FIGURE 23. Add Pages - Add Devices Window

Add Page

Specify Device Group Box

Use the Specify Device group box to enter specific information about the RVON device you are adding to the application,
such as IP Address, Description, and Device Type.

IP Address Field

The IP Address field is used to enter the IP Address of the RVON device you want to add to RVONedit. Once the IP Address
is entered, the Find button becomes active.

Find Button
The Find button is used to search and find the IP Address you enter in the IP Address field.

Description Field
The Description field is used to enter a description of the RVON device you are adding to the application.

NOTE: If the description is different from the configured RVON device, the description is overwritten with the original
description.

Device Type Drop Down List

The Device Type drop down list is used to select the type of RVON device for which you are searching.

Available selections for this field are RVON-8, RVON-Keypanel, RVON-I/O, RVON-C, and RVON-16.
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Device Information Group Box

The Device Information area on the Add Device window displays information for the selected devices. Information includes:
IP Address
Description
Type

Sessions

NOTE: This information is for display only, you cannot modify the information in the window.

Add Button
The Add button is used to add the selected device to the device catalog.

Done Button

The Done button is used to close the Add Device window.

Search Page

FIGURE 24. Search Page - Add Devices Window

Available Devices Group Box

The Available Devices list displays every configured RVON device in the intercom system.

NOTE: You can add multiple RVON devices by holding down the Ctrl button and selecting each device individually or
hold the Ctrl+Shift and highlight the entire block of devices.

Device Information Group Box

The Device Information area on the Add Device window displays information for the selected devices. Information includes:
IP Address
Description
Type
Sessions
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NOTE: This information is for display only, you cannot modify the information in this window.

Add Button
The Add button is used to add the selected device to the device catalog.

Done Button

The Done button is used to close the Add Device window.
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Send Changes

The Send Changes window, shown in Figure 25, is used to select RVON devices and configuration modifications made to
RVON devices and send them to the device. Send Changes allows you to verify and confirm the modifications about to be
implemented and allows you to clear any of the device or configuration check boxes to cancel specific modifications from
being sent.

NOTE: RVONedit version 2.0.0 and higher is now able to open more than one window at a time. In turn, you can modify
and send multiple device modifications simultaneously. For more information, see “How to Send Changes” on
page 59.

This window only shows those items that have had changes made to them. If no changes have been made, the grid item will

not appear. For example, if you make changes to the IP Address on the RVON device, but make no changes to the description,

the IP Address check box appears, but the Description check box does not appear.

NOTE: To send changes to the intercom, you must have Write or Admin access rights for the data being sent.

Channel Configuration Page

FIGURE 25. Channel Configuration Page - Send Changes Window
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Review Changes Group Box

Select Devices To Send Box

Changed Devices List

The Changed Devices list displays a list of RVON devices with modifications made to their configurations. When the check
box next to the device is selected, the device changes will be sent to the device.

Select Attributes of Selected Device to Send

Changed Channel Attributes

The Changed Channel Attributes list displays a list of channel attributes and channels that have modifications made to them.
Depending on the RVON device you select, the number of displayed channel columns varies from 8 to 16.

When an attribute and channel have a change pending, the check box next to the attribute oand channel becomes active.

If you clear the check box, the change is not implemented on the device..

> Select each attribute and channel you want to allow the changes to be made upon.
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Channel Description Check Box

The Channel Description check box indicates modifications have been made to the Channel Description field. If selected
when a Send Change is performed, the modifications are sent to the device. Otherwise, the modifications are not sent.
Destination Type Check Box

The Destination Type check box indicates modifications have been made to the Destination Type field. If selected when
a Send Change is performed, the modifications are sent to the device. Otherwise, the modifications are not sent.
Destination IP Address Check Box

The Destination IP Address check box indicates modifications have been made to the Destination IP Address field. If
selected when a Send Change is performed, the modifications are sent to the device. Otherwise, the modifications are not
sent.

Destination Channel Check Box

The Destination Channel check box indicates modifications have been made to the Destination Channel field. If selected
when a Send Change is performed, the modifications are sent to the device. Otherwise, the modifications are not sent.
Coding Profile Check Box

The Coding Profile check box indicates modifications have been made to the Coding Profile field. If selected when a
Send Change is performed, the modifications are sent to the device. Otherwise, the modifications are not sent.

VAD Threshold Check Box

The Vad Threshold check box indicates modifications have been made to the VAD Threshold field. If selected when a
Send Change is performed, the modifications are sent to the device. Otherwise, the modifications are not sent.

Channel Input Gain Check Box

The Channel Input Gain check box indicates modifications have been made to the Channel Input Gain field. If selected
when a Send Change is performed, the modifications are sent to the device. Otherwise, the modifications are not sent.
Channel Output Gain Check Box

The Channel Output Gain check box indicates modifications have been made to the Channel Output Gain field. If
selected when a Send Change is performed, the modifications are sent to the device. Otherwise, the modifications are not
sent.

Keypanel Polling ID Check Box

The Keypanel Polling ID check box indicates modifications have been made to the Keypanel Polling ID field. If selected
when a Send Change is performed, the modifications are sent to the device. Otherwise, the modifications are not sent.
Keypanel Polling Baud Rate Check Box

The Keypanel Polling Baud Rate check box indicates modifications have been made to the Keypanel Polling Baud Rate
field. If selected when a Send Change is performed, the modifications are sent to the device. Otherwise, the modifications
are not sent.

Auto-Close After All Changes Sent Successfully Check Box

The Auto-Close After All Changes Sent Successfully check box is used to enable the Send Change window to
automatically close the when all changes have been sent successfully.
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Device Configuration Page

FIGURE 26. Device Configuration Page - Send Changes Window

Review Changes Group Box

Select Attributes of Selected Devices Send List

IP Address Check Box

The IP Address check box indicates modifications have been made to the IP Address field. If selected when a Send
Change is performed, the modifications are sent to the device. Otherwise, the modifications are not sent.

Description Check Box

The Description check box indicates modifications have been made to the Description field. If selected when a Send
Change is performed, the modifications are sent to the device. Otherwise, the modifications are not sent.

Ethernet Settings Check Box

The Ethernet Settings check box indicates modifications have been made to the Ethernet Settings field. If selected when
a Send Change is performed, the modifications are sent to the device. Otherwise, the modifications are not sent.

Pass-Through IP Address Check Box

The Pass-Through IP Address check box indicates modifications have been made to the Pass-Through IP Address field.
If selected when a Send Change is performed, the modifications are sent to the device. Otherwise, the modifications are
not sent.
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Pass-Through Baud Rate Check Box

The Pass-Through Baud Rate check box indicates modifications have been made to the Pass-Through Baud Rate field.
If selected when a Send Change is performed, the modifications are sent to the device. Otherwise, the modifications are
not sent.

GPI10 Mode Check Box

The GP10O Mode check box indicates modifications have been made to the GPIO Mode field. If selected when a Send
Change is performed, the modifications are sent to the device. Otherwise, the modifications are not sent.

GPI10O Mode IP Address

The GP10O Mode IP Address check box indicates modifications have been made to the GPIO Mode IP Address field. If
selected when a Send Change is performed, the modifications are sent to the device. Otherwise, the modifications are not
sent.

SNMP Information Check Box

The SNMP Information check box indicates modifications have been made to the SNMP Information field. If selected
when a Send Change is performed, the modifications are sent to the device. Otherwise, the modifications are not sent.
Auto-Close After All Changes Sent Successfully Check Box

The Auto-Close After All Changes Sent Successfully check box is used to enable the Send Change window to
automatically close the when all changes have been sent successfully.
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Paste Special Window

The Paste Special window, shown in Figure 27, is used to select different channel and/or device configuration items that have
been copied from one device to the current RVON device.

The Paste Special window has two pages — Channel Configuration Page and Device Configuration Page.

Channel Configuration Page

The Channel Configuration Page, shown in Figure 27, is used to select the options you want to copy to the device and then
select the channels on the selected device you want to paste the selected configuration options.

FIGURE 27. Channel Configuration Page - Paste Special Window

Select Attributes to Paste Group Box

Changed Devices List

Channel Configuration List

The Channel Configuration list displays the channels available to paste channel information into, if applicable. Depending
on the RVON device you have selected, the number of displayed channel columns varies. If you have an RVON-8 device
selected, 8 channel columns are shown, if you have an RVON-16 selected, 16 channels are shown.

> Select each channel you want to allow the paste to be performed upon.
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Channel Description Check Box
The Channel Description check box indicates the channel description should be pasted into the new channel
configuration.

Select the Channel Description check box if you want to paste the channel description information to the new channel
configuration. Otherwise, clear the check box to do nothing

Destination Type Check Box

The Destination Type check box indicates the destination type should be pasted into the new channel configuration.
Select the Destination Type check box if you want to paste the destination type information to the new channel
configuration. Otherwise, clear the check box to do nothing.

Destination IP Address Check Box

The Destination IP Address check box indicates the destination IP Address should be pasted into the new channel

configuration.

Select the Destination IP Address check box if you want to paste the destination IP Address information to the new
channel configuration. Otherwise, clear the check box to do nothing.

Destination Channel Check Box

The Destination Channel check box indicates the destination channel should be pasted into the new channel
configuration.

Select the Destination Channel check box if you want to paste the destination channel information to the new channel
configuration. Otherwise, clear the check box to do nothing.

Coding Profile Check Box

The Coding Profile check box indicates the coding profile should be pasted into the new channel configuration.

Select the Coding Profile check box if you want to paste the coding profile information to the new channel configuration.
Otherwise, clear the check box to do nothing.

VAD Threshold Check Box

The VAD Threshold check box indicates the VAD threshold should be pasted into the new channel configuration.
Select the VAD Threshold check box if you want to paste the VAD threshold information to the new channel
configuration. Otherwise, clear the check box to do nothing.

Channel Input Gain Check Box

The Channel Input Gain check box indicates the channel input gain information should be pasted into the new channel

configuration.

Select the Channel Input Gain check box if you want to paste the channel input gain information to the new channel
configuration. Otherwise, clear the check box to do nothing.

Channel Output Gain Check Box

The Channel Output Gain check box indicates the channel output gain information should be pasted into the new
channel configuration.

Select the Channel Output Gain check box if you want to paste the channel output gain information to the new channel
configuration. Otherwise, clear the check box to do nothing.
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Keypanel Polling ID Check Box
The Keypanel Polling ID check box indicates the keypanel polling ID information should be pasted into the new channel
configuration.

Select the Keypanel Polling ID check box if you want to paste the keypanel polling ID information to the new channel
configuration. Otherwise, clear the check box to do nothing.

Keypanel Polling Baud Rate Check Box

The Keypanel Polling Baud Rate check box indicates the keypanel polling baud rate information should be pasted into
the new channel configuration.

Select the Keypanel Polling Baud Rate check box if you want to paste the keypanel polling baud rate information to the
new channel configuration. Otherwise, clear the check box to do nothing.

Device Configuration Page

The Device Configuration page, shown in Figure 28, displays the different options you can select to paste to the new device
configuration.

FIGURE 28. Device Configuration Page - Paste Special Window

Select Attributes to Paste... Group Box

IP Address Check Box

The IP Address check box indicates the IP Address information should be pasted into the new device configuration.

Select the IP Address check box if you want to paste the IP Address information to the new device configuration. Otherwise,
clear the check box to do nothing.

46



Netmask Check Box

The Netmask check box indicates the Netmask information should be pasted into the new device configuration.

Select the Netmask check box if you want to paste the Netmask information to the new device configuration. Otherwise, clear
the check box to do nothing.

Gateway Check Box
The Gateway check box indicates the Gateway information should be pasted into the new device configuration.

Select the Gateway check box if you want to paste the Gateway information to the new device configuration. Otherwise, clear
the check box to do nothing.

Description Check Box
The Description check box indicates the description information should be pasted into the new device configuration.

Select the Description check box if you want to paste the description information to the new device configuration. Otherwise,
clear the check box to do nothing.

Ethernet Settings Check Box
The Ethernet Settings check box indicates the Ethernet settings information should be pasted into the new device
configuration.

Select the Ethernet Settings check box if you want to paste the Ethernet settings information to the new device configuration.
Otherwise, clear the check box to do nothing.

Pass-Through IP Address Check Box
The Pass-through IP Address check box indicates the pass-through IP Address information should be pasted into the new
device configuration.

Select the Pass-Through IP Address check box if you want to paste the pass-through IP Address information to the new device
configuration. Otherwise, clear the check box to do nothing.

GPI10 Mode Check Box
The GP1O Mode check box indicates the GPIO mode information should be pasted into the new device configuration.

Select the GPIO Mode check box if you want to paste the GPIO mode information to the new device configuration. Otherwise,
clear the check box to do nothing.

GPIO IP Address Check Box
The GPIO IP Address check box indicates the GP1O IP Address information should be pasted into the new device
configuration.

Select the GP1O IP Address check box if you want to paste the GPIO IP Address information to the new device configuration.
Otherwise, clear the check box to do nothing.

GPI10 Keypanel Check Box
The GPIO Keypanel check box indicates the GPIO keypanel information should be pasted into the new device configuration.

Select the GPIO Keypanel check box if you want to paste the GPIO keypanel information to the new device configuration.
Otherwise, clear the check box to do nothing.
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Options button

The Options button, shown in Figure 29, displays pop-up options for the Paste Special window. These options are explained
in detail in the following paragraphs.

FIGURE 29. Options Button - Paste Special Window

Show Clipboard Selections Pop-up Option

The Show Clipboard Selections pop-up option indicates only those items you copied appear in the Paste Special window.

Show Paste Special Defaults Pop-up Option
The Show Paste Special Defaults pop-up option indicates the defaults set to show for the Paste Special window appeatr.

By default, all channels and all configuration options are selected. You can remove the check mark from any of the check
boxes you do not want to paste into the new configuration page.

Save Selections As Paste Special Defaults Pop-up Option

The Save Selections As Paste Special Defaults pop-up option saves the currently selected options as the paste special
defaults.
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FIGURE 30. Select, Clear, Invert Attributes

All Attributes Pop-up Option

The All Attributes pop-up option is used to select, clear or invert all attributes listed on both the Device and Channel
Configuration pages.

The available selections are
Select- selects and places a check mark in every check box on all channels.
Clear— clears all check marks from every check box.

Invert- reverses the all selections in the current Device and Channel views. For example, selected check boxes are
cleared, while deselected check boxes become selected.

Device Attributes Pop-up Option
The Device Attributes pop-up option is used to select, clear or invert attributes listed on Device Attributes page.
The available selections are

Select- selects and places a check mark in every check box on the page.

Clear- clears all check marks from every check box on the page.

Invert- reverses the all selections on the current Device page. For example, selected check boxes are cleared, while
deselected check boxes become selected.

Channel Attributes Pop-up Option
The Channel Attributes pop-up option is used to select, clear or invert attributes listed on Channel Attributes page.
The available selections are

Select— selects and places a check mark in every check box on the page.

Clear- clears all check marks from every check box on the page.

Invert— reverses the all selections on the current Channel page. For example, selected check boxes are cleared, while
deselected check boxes become selected.
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Download Firmware Window

The Download Firmware window, shown in Figure 31, is used to easily upgrade the firmware for any of the RVON devices.
Remember, you must have Download privileges before you can download firmware to RVON devices.

For detailed information, see “How to Download Firmware Upgrades in RVONedit” on page 56.

RVONedit can download firmware to any RVON device with the following firmware versions:

FIRMWARE VERSION
RVON-8 V 1.2.0 or higher
RVON- .
Keypanel V 1.1.0 or higher
RVON-I/O V 1.0 or higher
RVON-C V 1.0 or higher
RVON-16 V 2.0.0 or higher
NOTE: You can only download firmware for one type of RVON device at a time. You can download to multiple RVON

devices that are the same.

FIGURE 31. Download Firmware Window

Select Device Type Drop Down Menu
The Select Device Type drop down menu is used to select the type of RVON device for firmware upgrade.

Options available are: RVON-8, RVON-Keypanel, RVON-1/0, RVON-C, and RVON-16.
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Select Devices To Download Field
The Select Devices To Download field displays the following information:

IP Address- Displays the IP Address of the RVON device (for example, 192.168.1.29).
Description- Displays the textual description of the RVON device (for example, slot 9).
Firmware Version- Displays the version of firmware that currently resides on the RVON device.

Status- Displays the status of the download of the firmware to the RVON device. A blue status bar with each
of the following:

e Sending
*  Finishing
e Complete

If you click Stop before the download is complete or something did not allow the download to
finish, you will see a failed message in this column

Select Firmware Drop Down Menu

The Select Firmware File drop down menu displays the firmware for download. If you have downloaded different version of
the firmware and downloaded them to other RVON devices, and then you are able to use the drop down list to see the different
versions that have been downloaded to other devices.

Auto-Close After Successful Download Check Box

The Auto-Close After Successful Download check box is used to indicate the Download Firmware window automatically
closes when the firmware download is complete.

Begin Button
The Begin button is used to start the firmware download.

For more information, see “How to Download Firmware Upgrades in RVONedit” on page 56.
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CHAPTER 3

Application Tasks

In this chapter you will find many setup and maintenance tasks that you may only perform once or perform on a daily basis:

How to Open Multiple Windows in RVONedit

RVONedit version 2.0.0 and higher now allows you to open multiple RVONedit windows and make changes to multiple
devices simultaneously. Also, you are able to send changes made to multiple devices at the same time. Before version 2.0.0,
you were able to send changes for one device at a time.
There are three (3) ways to open new windows in RVONedit:

Window|New

Shift + Click in the device catalog

Right-click menu

To open a new window using the menu bar, do the following:

> From the Window menu, select New.
A new RVONedit window appears.

To open a new window using Shift+click in the device catalog, do the following:

1. On the keyboard, press and hold down the Shift key.

2. Using the mouse, click anywhere in the device catalog area of the application window.
A new RVONedit window appears.
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To open a new window using a right-click, do the following:
1. Inthe Device Catalog area, right-click on either an RVON device, All Devices, or By Device Type icon.
A popup menu appears.

2. From the popup menu, select Open in a new window.
A new RVONedit window appears.

How to Add Devices to RVONedit

Once you have installed the RVONedit application, you must then add the device to be monitored or displayed. This may be
done automatically or manually by entering the IP (Internet Protocol) Address.

To search for RVON devices, do the following:

1. From the RVON menu, select Add.
The Add Devices Window appears

2. Verify you are on the Search page of the Add Devices window.
3. From the Available Devices list, select the IP Address of the device you want to add to RVONedit.

NOTE: You can add more than one device at a time by doing the following:
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* Toselectablock of IP Addresses, highlight the first IP Address, press and hold Ctrl+Shift,
and then scroll and select the last IP Address in the block you want.
All of the IP Addresses are selected.

* Toselect multiple IP Addresses that are not in a block, press and hold the Ctrl key, then select
the IP Addresses you want to add to RVONedit.

*  Notice in the IP Address field under Device Information on the right-hand side of the
application pane, you can see <multiple selections>.

>

4. Click Add.
The devices are added to the RVONedit Catalog view.
5. Click Done.

The Add Devices Window closes.

To add a Device manually to RVONedit, do the following:
1. From the RVON menu, select Add.
The Add Devices Window appears

2. Click the Add page.
The Add Dialog appears.

3. Under Specify Device, add the IP Address of the device to which you want to connect.
Once you have entered the IP Address, the Find button becomes active.

NOTE: You can only add one device at a time when entering the IP Address manually.
4. Click Add.
The Add Device Window remains open and the RVON device is added to the Catalog view on the main Window.
5. Repeat steps 1-3 to add more devices manually.

6. Once finished, click Done.
The Add Devices window closes.
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How to Download Firmware Upgrades in RVONedit

Occasionally, RVON products have firmware upgrades. Once you have upgraded the RVON products to the required versions
(see page 3) through AZedit, Telnet, or serially, you can download firmware from RVONedit directly to the device.

To download firmware to the RVON cards, do the following:

1. From the RVON menu, select Download Firmware.
The Download Firmware window appears.

2. From the Device Type drop down menu, select the type of device to be upgraded with firmware (for example,
RVON-8, RVON-Keypanel, RVON-1/0, RVON-C, or RVON-16).

3. From the Select Devices to Download: list, select the devices to which you want to apply the firmware.

NOTE: You can add more than one device at a time by doing the following:

* Toselect a block of devices, select (highlight) the first device, press and hold Ctrl+Shift, and
then scroll and select the last device in the list.
All of the devices are selected.

*  To select multiple devices that are not in a block, press and hold the Ctrl key, then select the
devices one-by-one to add to RVONedit.

4. In the Select Firmware File field, enter the path to the firmware update, or use the browse button ... to navigate to
the file.

5. Select the Auto-close after successful download check box, if you want to close the Download Firmware Window
immediately after a successful download.

6. Click Begin.
The Download begins.

NOTE: This may take a few minutes. You can watch the download using the RVON device download
status bar.
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Once the download is complete, it may take a few minutes for the RVON devices to reboot themselves. You can also watch as
the device blocks dim, and then re-light with the reboot.

7. Repeat steps 1 through 6 to download firmware to other RVON devices, otherwise click Done.
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How to Change a User

To change a user in RVONedit, do the following:

1. From the RVON menu, select Change User.
The Change User Window appears.

In the User Name field, enter the User Name (up to 40 characters) of the profile you want to log on to RVONedit.
In the Password field, enter the password (up to 40 characters) for the profile you are logging onto RVONedit.
Click Save, if you want the user name and password retained for future logins to this machine.

Click OK to confirm the user name and password. Otherwise, click Cancel.

o  w N
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How to Send Changes

When changes or modifications are made to most configuration options in RVONedit, they are not applied to the device until
the changes are sent to the device.

NOTE: RVONedit version 2.0.0 and higher, supports making and sending changes for multiple devices.

To send changes to the device, do the following:

N

1. From the Changes menu, select Send or click the Send Changes icon.
The Send Changes window appears.

2. On the Send Changes Window, review the changes you are about to send to the device.

3. Make any modifications necessary.
4. Click Send when you are finished, otherwise click Cancel.
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How to Copy and Paste Channel Settings

RVONedit supports copying and pasting individual channel configuration setting, making it easy to setup configuration files
for different channels on the same device or for channels on different devices.

To copy and paste channel settings, do the following:

1.

2.

From the Device Catalog, select the device you want to copy the channel configuration settings.
In the Channel Configurations section, select the channel column header of the channel you want to copy.

From the Edit menu, select Copy or click the copy icon.
The channel settings are copied.
NOTE: You can also copy the settings by pressing Ctrl+C on the keyboard.

In the same Channel Configuration Grid, select a different channel column header on the same device
OR
select a different device’s channel column.

From the Edit menu, select Paste or click the paste icon. E‘
The copied information appears in yellow highlight.

NOTE: You can also paste the settings by pressing Ctrl+V on the keyboard.

Send or Save your changes.

60



Use Paste Special to Paste Device Settings.

Paste Special allows you to copy entire device configuration settings of a device and then select specific configuration settings
to paste to a new device.

To paste device settings using paste special, do the following:
1. From the Device Catalog, select the device to which you want to copy the device settings.

2. From the Edit menu, select Copy or click the copy icon.
The Device Settings are copied.

NOTE: You can also copy the settings by pressing Ctrl+C on the keyboard.

3. From the Device Catalog, select the device to which you want to copy the device settings.

4. From the Edit menu, select Paste Special.
The Paste Special window appears.

5. Select the check boxes of the device configurations you do NOT want to paste to the new device.

6. Once you are finished, click Paste.
The settings are pasted to the current device.

7. Send or Save the changes.
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Use Paste Special to Paste Channel Settings

Paste Special allows you to copy channel configuration settings of a device and then select specific channel settings to paste to
a new device.

To paste channel settings using paste special, do the following:
1. From the Device Catalog, select the device to which you want to copy channel settings.
Ex
2. From the Edit menu, select Copy or click the copy icon.
The channel settings are copied.

NOTE: You can also copy the settings by pressing Ctrl+C on the keyboard.

3. From the Device Catalog, select the device to which you want to copy channel settings.

4. From the edit menu, select Paste Special.
The Paste Special window opens.

5. Clear the check boxes of the channel settings and the channels you do NOT want to paste.

6. Once you are finished, click Paste.
The current settings are pasted to the current device.
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How to Open Preferences

You can configure the RVONedit application by setting some of the application configurations to fit your individual business
needs.

To open the Preferences window, do the following:

1. From the Edit menu, select Preferences or click the preferences icon. F
There are four pages in the Preference Dialog notebook. These pages contain the following:

Device Catalog Configurations - You can set how you see the devices in the catalog (By Type or All Devices). You can
also enable using the Device Description instead of the IP Address in the Device Catalog.

Row and column adjustments

Show/Hide Informational Areas - You can show or hide SNMP and/or the Authentication area of the Device
Configuration section of the application.

Default Information Folders - You can set the default folders to where RVONedit will save information for Device
Catalogs, Setup Files, and Firmware Files.
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How to Show/Hide the Device Catalog

Once you have added devices to the device catalog, you are ready to configure them. If you do not have a need to refer to a
device in the device catalog, you can hide the whole section, creating more room in the application window.

There are several ways to Hide/Show the Device Catalog, described below:

>  Double-click the divider bar.

> From the View menu, select Device Catalog.
When a check mark is beside Device Catalog, the catalog is showing. If there is no check mark present, the catalog is

hidden.

> Press Ctrl+T on the keyboard. to hide the Device Catalog.
Press Ctrl+T on the keyboard again to open the Device Catalog.
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Use Device Descriptions in the Device Catalog

Sometimes it is easier to recognize a unique name for a device, rather than its IP Address. You can configure RVONedit to
show device descriptions (where available) in the device catalog.

To enable device descriptions in the device catalog, do the following:

1. From the Edit menu, select Preferences. or click the preferences icon. lF
The Preferences window appears.

2. Click the Catalogs page.
The Catalog page appears.

3. Select the Use description instead of IP address if available check box.
4. Click OK.
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How to Show/Hide the SNMP Configuration Information

If you are currently not using SNMP in your Intercom System, you may choose to hide the SNMP configuration area in the
Device Configuration and Status section of the application.

To hide SNMP configuration information, do the following:

1. From the Edit menu, select Preferences or click the preferences icon. F
The Preferences window appears.

2. Click the Devices page.
The Devices page appears.

3. Select the Hide SNMP Configuration check box.
4. Click OK.
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How to Show/Hide the Authentication Table

If you are currently not using Authentication in your Intercom Systems, you may choose to hide the Authentication table in the
Device Configuration and Status section of the application.

To hide the authentication table, do the following:

1. From the Edit menu, select Preferences or click the preferences icon. lF
The Preferences window appears.

2. Click the Devices page.
The Devices page appears.

3. Select the Hide Authentication table check box.
4. Click OK.
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How to Enable/Disable “Auto-connect the application when changing devices”

The Auto-connect the application when changing devices is a useful setting when you are viewing multiple devices in a
session. When enabled, devices automatically connect to RVONedit when selected. This way, you do not have to manually

connect the device.

To enable/disable auto-connect the application when changing devices option, do the following:

. . . W
1. From the Edit menu, select Preferences or click the preferences icon. |_
The Preferences window appears.

2. Click the Devices page.
The Devices page appears.

3. Select the Auto-connect the application when changing devices check box to enable. Or, clear the check box to
disable the option.
4. When finished, click OK. Otherwise, click Cancel.
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How to Save a Configuration File

Once you have made changes to a device’s configuration (both device and channel), save the configuration file for later use or
to compare with later configuration files.

NOTE: Setup files are stored in XML (extensible markup language) format, which makes them viewable and modifiable

in a standard text editor (Notepad, MS® Word, etc.) and are viewable in a web browser. The Authentication
Table, if saved, is stored in an encrypted format, so a text editor cannot edit it.

To save configuration files, do the following:

1. From the File menu, select Save or click the save icon. E
By default RVONedit stores all files in the Setups folder under the RVONedit directory. You may change this location
by setting the default location. For more information, see “How to Set a Default Folder in RVONedit” on page 81.

2. Click Save.

NOTE: Regardless of where the setup files are stored, RVONedit always stores setup files for each device in a separate
sub-directory named using the device’s IP Address. This keeps the setup files for each device separate from other
devices.

NOTE: When saving a setup file, RVONedit does not include the configuration items the device is not capable of

supporting (for example, SNMP, Pass-Through, or GPIO information). Also, it will not save the SNMP or
Authentication Table unless the current user has admin rights and the preferences to hide these areas is not
enabled.
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How to Load a File

Load File can be used to preview (and modify) items in a file. Loading a setup file is similar to opening a setup file. For the
differences between File|Open and File|Load, see page 83.

To load a setup file, do the following:

H
1. From the File menu, select Load... or click the load icon.
The Load window appears.

2. Navigate to the file you want to load.

3. Click Open.
The file loads on top of the current configuration.

NOTE: When a file is loaded, the file overlays current device configurations. You can modify the loaded
file to suit your needs. Once done making changes (if applicable) to the loaded file, you need to
send changes to the device.

A

4. From the Changes menu, select Send (F10) or click the send changes icon.
OR
Save the configuration file.
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How to Add/Remove a User Profile To/From the Authentication Table

NOTE: To setup user profiles, you must have ‘Admin’ rights. For more information, see “Authentication Information
Section” on page 15. Also, you cannot have Hide Authentication Table enabled.

To add user profile to the authentication table, do the following:

1. Inthe Device Configuration section, scroll to the Authentication Information area.

2. Click Add.
The User Name field becomes active and the table line is highlighted in yellow.

3. Inthe User Name field, enter a user name for the new profile (up to 40 characters long).

4. Double-click the Password field to make it active.
5. Enter a password (up to 40 characters).

6. Select the Access Rights check boxes you want for this profile.
7. Send or Save your changes.

To remove a user profile from the authentication table, do the following:
1. Click the user profile you want to remove from the authentication table.
The profile is highlighted blue.

2. Click the Remove button.
The user profile is removed from the authentication table.

3. Send or Save your changes.
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How to Expand/Collapse the Device Configuration Information Areas

Similar to the Channel Grid, you can hide the four (4) areas (individually) of the Device Configuration section of the
application.

To collapse a section that has been expanded, do the following:

> In the Device Configuration section, click the collapse icon J in the upper right corner of the section you want to
close.
The section closes.

To Expand a section that has been collapsed, do the following:

> In the Device Configuration section, click the expand icon # in the upper right corner of the section you want to
open.

The section opens.

How to Show/Hide Channel Columns

To show/hide channel grid columns, do the following:

1. Right-click the channel column header.
A context menu appears.

2. Select Hide Channel X (X being the channel column you want to hide).
3. Repeat steps 1 and 2 until you are finished hiding columns.
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To show hidden columns, do the following:

1. Right-click the channel column header to open.
A context menu appears.

2. Select Show Channel.
A context menu appears.

3. Select the specific channel you want to open or select All Channels to open all hidden channels.
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How to Undo, Redo, and Abort Changes

UNDO
Use Undo to cancel one or more previous changes. There are no limits on the amount of times you can undo changes.

NOTE: Every time an abort changes, send changes, or File|Open/Load/Send is performed the undo history is cleared to 0
previous actions.

To undo changes, do the following:

1. From the Change menu, select Undo (Ctrl+Z). Or click the Undo icon. =
The current action performed in RVONedit is undone.

REDO

Use Redo to revert one or more previous undo actions that you have done. There are no limits on the amount of times you can
redo changes.

NOTE: Every time an abort changes, send changes, or File|Open/Load/Send is performed, the redo history is cleared to 0
previous actions.

To redo actions, do the following:

1. From the Change menu, select Redo (Ctrl+Shift+Z). Or, click the Redo icon. L

ABORT

To abort the changes, do the following:

1. From the Change menu, select Abort or click the abort icon. X
A message asking “Are you sure you want to abort all pending changes?” appears.

2. Click Yes to accept. Otherwise, click No to do nothing.
By clicking Yes, the changes are deleted and the warning message closes. By selecting No, the changes are untouched
(and still active to be sent to the device) and the warning message closes.
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How to change the IP Address, Netmask, and Gateway

To change the IP Address, Netmask, and/or Gateway Address for a device, do the following:

1.
2.

In the Device Configuration and Status section, modify the IP Address, Netmask, and/or the Gateway fields.
Once finished, Send or Save the changes to the device.

How to Setup the Pass-Through Port

NOTE:

To make changes to the Pass-Through port you must have Write access to make changes to this area.

To setup the pass-through device, do the following:

1.

In the Device Catalog, select a device.
The Device Configuration displays the current configurations for the device.

In the Tx IP Address field, enter the IP Address to which the device will transmit audio.
From the Baud Rate drop down list, select the baud rate at which audio will be transmitted.
Once finished, Send or Save the channels to the device.

How to Setup the GPIO for an RVON-1/0O

NOTE:

The GPIO section will only display if the device has Pass-Through or GP1O capabilities. To make changes to the
GPIO you must have Write access to make changes to this area.

To setup the GP1O for an RVON-1/O, do the following:

1.

o > w N

In the Device Catalog, select an RVON-1/0O.
The Device Configuration displays the current configurations for the RVON-1/O device.

From the Mode drop down list, select the GP1O mode the device will run.

In the IP Address field, enter the GP1O IP Address (if applicable).

From the Keypanel drop down list, select the keypanel or port in which all GP1Os are associated.
Once finished, Send or Save the changes to the channels.

How to Manually Disconnect from RVONedit

To manually disconnect from RVONedit, do the following:

1.

From the RVON menu, select Disconnect.
The RVON device is disconnected. The green check mark turns to a red X.

OR

From the toolbar, select the disconnect icon. I‘:l"
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How to Open a File

When a file is opened in RVONedit, the application will disconnect from the current device (if connected) and read the setup
file. If the file being opened is for a device other than the current device, RVONedit will create the device in the catalog and

switch to it.

To open a file, do the following:

|
1. From the File menu, select Open or click the open icon. (=
The Setup file window appears.
NOTE: If a catalog device is currently selected, RVONedit will default to showing you the files in the sub-

directory named for the current devices’s IP Address. You can also use the File Open window to
navigate to a different location to select a different directory to open.

2. Select the file you want to open in RVONedit and then click Open.
If the field is for a device other than the current device, RVONedit switches to the new device in the catalog. If the file
is for a device that is not in the catalog, RVONedit will create a device in the catalog for the device.

3. Make any modifications or changes.

4. Save the setup file. You can also attempt to connect to the device and Load the file using Send Changes command.

NOTE: RVONedit will not read the SNMP Configuration or Authentication Table from the file unless you have ‘Admin’
rights, AND the preference to hide these sections is not enabled.
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How to Use the Forward and Back button

RVONedit remembers the devices that you view as you use the application (this function can be compared to a web browser’s

4 e

or the Go Forward button , You can back-track or go forward to devices you

history). Using the Go Back button
have already viewed.

How to Change Devices using the Device Catalog Tree

As with most of the actions in RVONedit, there are many ways to accomplish the same action. Changing devices is no
exception. Not only can you use the F3 action, you can simply point and click, as well.

To use the device catalog tree to change devices, do the following:
1. Inthe device catalog, click the device you want to configure or view.
The device configuration and channel configuration for the selected device appear.
2. To move to the device, click the device in the catalog.

NOTE: If you do not have the “Auto-connect the application when changing devices” option enabled, you may have to
log on to each device when you switch devices. For more information on how to enable this feature, see “How to
Enable/Disable “Auto-connect the application when changing devices”” on page 68.

How to Change Devices using F3

RVONedit supports a toggle feature that allows you to toggle between the destination IP Addresses of two connected RVON
devices using the F3 function key.

To toggle between two devices that share a connection, do the following:

1. While the keyboard focus is on any field containing a destination IP Address, press F3 on the keyboard.
The destination IP Address device becomes active allowing you to make configuration changes, if needed.

This action affects the Destination IP Address field in the Channel Configuration Grid and the Tx IP Address field in the Pass-
Through and/or GPIO section.

NOTE: The destination device must be configured in RVONedit for this feature to work.
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How to Hide Individual Rows in the Channel Configuration Grid

RVONedit supports hiding individual rows within the Channel Configuration Grid. You can easily hide rows of information
you do not want to view; leaving only the data you are interested in viewing.

To hide individual rows in the channel configuration grid, do the following:

1. Right-click the row you want to hide.
A Hide <specified row> row menu item appears.

2. Select the Hide <specified row> row menu item.
The row is hidden.
3. Repeat steps 1 and 2 until you have hidden all the rows you want.
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To show all the rows you have hidden, do the following:

1. Right-click the area where the rows are hidden and then select Show Attribute.
The hidden rows menu appears.

2. You can either select individual rows to show or select All Attributes to restore all of the rows.

How to Tear Down a Channel

The Tear Down a Channel feature is used to reset a channel without rebooting the entire device. When a tear down is
performed the device disconnects the audio channel and then reconnects the channel.

To tear down a channel, do the following:

1. In the Channel Configuration Grid, right-click a channel column header.
A context menu appears.
2. From the context menu, select Tear Down Channel X (X being the channel. For example, Channel 1, Channel 2,

etc.).
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How to Set the Column Size in the Channel Configuration Grid

To set the column size, you must have the Allow column width adjustments check box selected. You can find this option on the
Channels page of the preferences window (Edit|Preferences).

To set the column size, do the following:

1. Right-click the column header where you want to size and then click Column Size.
The column size options menu appears.
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2. Choose one of the four column sizing options:

Auto-size this column - The column is resized to fit the text in the column.
Auto-size all columns - All columns are resized to fit the text in each column.
Auto-fit all columns to fit window size - The columns are adjusted to fit all columns within the Channel

Configuration window.
Set all columns to this size - After manually resizing a column, you can select this option to make all
the columns the same size based upon the selected column.

NOTE: As always, you can manually adjust individual columns. Click and drag the outside edge of the column you want
to resize.

How to Set a Default Folder in RVONedit

Using the Directories page in the Preferences window (Edit|Preferences), you can change the folder used to store different
RVONedit files, such as Setups, Authentication, and Firmware files.

To change the default folder for RVONedit, do the following:

1. From the Edit menu, select Preferences.
The Preferences window appears.

NOTE: You can also click the preferences icon. lF
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2.

3.

4.

Select Directories.

In one of the file fields (Device Catalog, Device Setup Files or Firmware Files), enter the file path where you want to

save each type of file. You can also use the browse button —| to navigate to the folder.
Once you are finished, click OK.
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What is the Difference Between File|Open and File|Load?

While primarily the same, there are distinct differences between File|Open and File|Load.

File|Open

If the application is connected to a device when File|Open is performed, it automatically
disconnects when the file is opened.

If a catalog device is currently selected when the File|Open is performed, RVONedit will
disconnect (if connected) from the current device and read the file.

If the file that is opened is for a different device, RVONedit will switch to the new device in
the catalog. If the new device is not in the catalog, it will create the device with the file
parameters.

After a file has been opened, you can view/modify the configuration settings. You can save the changes to the existing file or
create a new setup file by performing a File|Save. You can also connect to the device and Send the changes to the device.

File|Load

The application is not disconnected from the current device (if connected).

The setup file may contain information for a device other than the device you are currently
viewing. RVONedit will not switch to the new device.

The items in the setup file are overlaid on the current device and marked as changed when they
are read.

After a file has been loaded, you can modify the file before you sent it to the device using the Send Changes command.

NOTE:

Partial loads and partial saves are not supported in RVONedit. This means that all information in a setup file that
can be loaded will be loaded.
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How to Manually Connect an RVONedit device

To manually connect an RVONedit device, do the following:

1. Highlight the RVON device with which you want to connect.
Notice the RVON device has a red X signifying that it is not connected.

2. From the RVON menu, select Connect.
The red X changes to a green ¢/. If the device does not have any logons associated with it, it will automatically

connect. Otherwise, a logon window appears, prompting for you for a user name and password.

How to Update Older Version RVON Devices Using RVONedit

In RVONedit you can add an RVON device that does not have the required firmware installed, but not be connected to it (the
device icon is dimmed). But, if the device is running a lower version firmware (as noted below), you can update to the required

firmware version.
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To update older version RVON devices, do the following:

FIRMWARE VERSION
RVON-8 V 1.2.0 or higher
RVON-Keypanel V 1.1.0 or higher
RVON-I/O V 1.0 or higher
RVON-C V 1.0 or higher
RVON-16 V 2.0.0 or higher

1. From the RVON menu, select Add.
The Add devices window appears.

Click the Add page.
In the IP Address, enter the IP Address of the RVON device without the required firmware.
From the Device Type drop down list, select the type of device it is (for example, RVON-8).

Click Add.
The RVON device is added to the catalog, but the RVON device is dimmed, which means that RVONedit cannot talk
with the device.

6. Select/highlight the RVON device you just added.

7. From the RVON menu, select Download Firmware.
The Download Firmware window appears.

8. From the Device Type drop down list, select the type of device you want to download the firmware (for example,
RVON-8).

a M w N

9. From the Select Device to Download list, select the device to which you want to upload the firmware.

NOTE: You can update more than one device at a time by doing the following:

* Toselect a block of devices, select (highlight) the top device, press and hold Ctrl+Shift, and
then scroll and select the last device in the block you want.
All of the devices are selected.

*  To select multiple devices that are not in a block, press and hold the Ctrl key, then select the
devices one-by-one you want to add to RVONedit.
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10. In the Select Firmware File: field, enter the path to the firmware update, or use the browse button. —I

11. Select the Auto-close after successful download check box, if you want to close the Download Firmware window
immediately after a successful download.

12. Click Begin.
The download begins.

NOTE: This may take a few minutes. You can watch the download and upgrade of the RVON device download status
bar.

How to Open the Manage Logins Window

The Manage Login window can be accessed in one of three different ways:
For one (1) device
For all devices

For all devices of a certain device type

To open the manage logins window for one (1) RVON device, do the following:

1. Inthe Device Catalog, right-click an RVON device.
A popup menu appears.

2. From the popup menu, select Manage Logins.
The Manage Logins window appears with the selected RVON device listed.

To open the manage logins window for all RVON devices, do the following:

1. From the application menu bar, select RVON.
The RVON menu appears.

2. From the RVON menu, select Manage Logins.
The Manage Logins window appears with every RVON device listed.

NOTE: You can also:



* Right-click the All Devices icon in the Device Catalog.
The Manage Logins window appears with all of the RVON devices listed in the order in which

they were added to the application.

* Right-click the By Device Type icon in the Device Catalog.
The Manage Logins window appears with all of the RVON devices listed by the device type.

To open the manage logins window for one RVON device type, do the following:

1. Inthe Device Catalog, expand the By Device Type icon.
The By Device Type navigation opens.

2. Right-click the device type icon for which you want to manage logins.
A popup menu appears.

Select Manage Logins.
The Manage Logins window appears with only the devices for the device type you selected.
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